
Key Travel Map CD-ROM for Windows

The Key Travel Map for Windows User Interface

The Key Travel Map Window

The Basic User Interface in  Key Travel Map  for Windows consists of two parts: accessing numerous
Menu choices, and movement around the map (or screen). Once Key Travel Map for Windows is opened,
a screen similar to the following is displayed:

The Key Travel Map Window

Movement on the map is achieved by using the  Scroll Bars at the bottom and on the right side of the
screen.

Clicking on the arrows on the right hand Scroll Bar causes the map to move up or down. Clicking on the
arrows in the Scroll Bar at the bottom of the screen moves the map to the right or left.

The amount of movement in the display is controlled by clicking and dragging the mouse pointer in the
Scroll Button of either Scroll Bar.
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The Key Travel Map for Windows Menus

One  of  Key  Travel  Map for  Windows'  unique  features  is  the  use  of  Pull  down Menus  and  an
accompanying Tool Bar. The Pull down Menus function as they do in most Windows programs: clicking
on a Menu item reveals further choices. Click on a particular choice to access it.

The Menu bar
  
The Tool Bar consists of  18 of  the most commonly used commands, providing instant  access to each
command. These Tools are discussed in this chapter along with the corresponding Pull Down Menus.

The Tool Bar

An additional  4 buttons are available to users of monitors operating in Super VGA (SVGA) mode. These
are as follows:

• The Arrow Tool
• The Distance Line Tool
• The Text Tool
• The Help Tool

All of the Pull down Menus are documented in full.

NOTE:  For  a  complete  listing  of  the  Tools  available  in  Key Travel  Map for  Windows refer  to
Appendix B.
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The Menu Bar

The Menu Bar at the top of the screen provides access to all of Key Travel Map for Windows commands.

The Menus available are:

File Illustrate
Edit Overlays
Streets Route
Places Help
View

Moving the mouse pointer to one of the keywords in the  Menu Bar and clicking the left mouse button
causes a Pull down Menu to be displayed. From the keyboard, Press ALT and the underlined letter key. In
the case of the  File Menu, Press Alt-F. This  Pull down Menu contains all of the commands that can be
accessed from the selected menu.

The File Menu

The File Menu commences a Key Travel Map for Windows session. Selecting the File Menu offers the
following choices as illustrated below:

The File Menu

Map Selection

This option enables the U.S. Highway maps and any Key CityMaps that may be loaded on the hard drive to
be accessed.
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The Map Selecetion Dialog box

NOTE: Key Travel Map for Windows includes the Hollywood, California Key CityMap.

Key CityMap Selection

To open a map, highlight the desired selection and click on  OK OR use the arrow keys to highlight the
selection and Press Enter. The selected map is immediately loaded into Key Travel Map for Windows.

NOTE: Throughout Key Travel Map for Windows, Pressing ESC achieves the same results as clicking on
the Cancel button.

A Key CityMap which has been loaded onto the hard drive can be opened by clicking the RIGHT mouse
button on the City Name while in the USA Map View. Available Key CityMaps are displayed in a different
color, depending on the display characteristics of the system.

Since there are many more Key CityMaps than can be displayed on the screen while at the USA Map view,
it may be necessary to Zoom in on an area to expose installed Key CityMaps. Consult the Key CityMap
Catalog for a list of available Key CityMap cities.

NOTE: Key Travel Map for Windows automatically searches for any Key CityMaps already loaded onto
the hard drive whenever the highway level maps are shown. As a result, any Key CityMaps on the system
are displayed in a contrasting color when at the USA Map level.
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Map Select Tool

A Map can be selected by clicking on the Map Tool in the Tool Bar, which causes the Map Selection Dialog
box to be presented. To select a map, highlight it with the mouse and click OK.

Any Key CityMaps on the hard drive are also available in this Dialog box.

NOTE: Whenever the mouse pointer is on one of the Tools a description of the corresponding command is
displayed in the lower left hand corner of the display, just above the horizontal scroll bar.

Open Session ...

The Open session.. command allows a previous session saved to the hard drive to be retrieved, including
any of the operating parameters and conditions during the session.

The Open Session Dialog box

All of the previously saved sessions are listed in The Open Session Dialog box with the  description to
identify the file. To select a particular session, highlight it with the mouse and click OK OR use the arrow
keys to highlight the desired session and Press Enter.

The first time Key Travel Map for Windows is opened, the only session available is the Key Travel Map
StartUp Session.

Provided that sessions are saved, the user can continue working from the point left off.

NOTE: Any changes made in a given session are not saved unless a request to save updates is made.

Existing sessions can be deleted from The Open Session Dialog box. To delete a session first highlight it
and click Delete. Before the deletion is executed The Delete Session Dialog box is presented for the user to
confirm the deletion:
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The Delete Session Dialog box

If Yes is selected, the session, including its' description and corresponding file, is deleted. If No is selected,
control is returned to the Open Session Dialog box.

Save Session...

The  Save session.. command is the opposite of the previous command.  Save session..  is used to save a
particular session, including any operating parameters and conditions being used. Selecting Save session..
reveals a Dialog box similar to the following: 

The Save Session Dialog box

A session must have a completed Filename and Description to be saved.

Description

A Description is mandatory. The Description for any saved session is presented in the Open Session Dialog
box. This Description can be a maximum of 34 characters and can be used to uniquely label any number of
sessions.

Filename

A Filename for the saved session  must be chosen in addition to the description. This  Filename cannot
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exceed eight letters in length and must conform to normal DOS characteristics. Refer to the DOS Manual
for the file naming procedure.
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The description is NOT a replacement for the Filename, merely an addition. It is used to identify any
existing session that is to be opened. The session must be saved with a unique Filename for Key Travel
Map for Windows to be able to retrieve it as a unique session.

The same description can be assigned to different filenames, so note carefully both the file currently being
saved and its' corresponding description. The description should be one which assists in locating the exact
session to be opened.

For  example,  to  save  a  session  with  the  intention  of  attempting  a  number  of  alternatives,  assign  a
description such as TEST MAP NORTH ROUTE, TEST MAP SOUTH ROUTE, etc., and save the file with
a unique name.  This  method precludes the need to  recall  the exact  filename,  due to  the fact  that  the
description is more indicative of the session's contents.

While the same description can be assigned to a number of different files, this is not true for the actual files
which correspond to a saved session. If an attempt is made to save a session file with a filename already in
existence, the following Dialog box is displayed:

Saving a Session to an Existing Filename

If Yes is selected, the existing file is overwritten. If No is selected, the program returns the user to the Save
Session Dialog box and the filename can be modified.

Save Session Tool

The "Camera" icon represents the Save Session Tool. Clicking on this Tool executes the same sequence for
saving a session as outlined in the previous section. The procedures and options are identical.
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Preferences

The  Preferences command  allows  many  of  Key  Travel  Map  for  Window's operating  and  display
characteristics to be customized. The Preferences Menu is divided into five different areas as illustrated
below:

         
The Preferences Dialog box

1 The Item Selector box, where the user selects the particular item to be customized.
2 The Item Indicator box, which displays the name of the item currently selected.
3 The Line Type Selector, where the user can select a different type or thickness of line for 

the selected item.
4 The Sample box, where any changes made are displayed instantly.
5 The Color Palette, showing the various colors which may be assigned to various areas of 

any map.

In addition to the aforementioned, the option of selecting different point sizes for any text to be displayed
on the screen is available. This option can be accessed by clicking on the Fonts>>>> Button on the right
side of the Preferences Menu.

Font Selection Dialog Box

When Fonts>>>> is selected from the Preferences Menu, the Fonts Selection Dialog box is displayed. In
this Dialog box the user can change the display size of any labels, street or city names and any text added to
a map. Like the Preferences Menu, the Font Selection Dialog box is divided into five areas:
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The Font Selection Dialog box

1 The Item Selector box, where the user can select the particular item to be customized.
2 The Item Indicator box, which displays the name of the item currently selected.
3 The Font Size Selector box, where the user can select from a number of different font sizes.
4 The Sample box, where any changes the user makes are displayed instantly.

The Color Palette, showing the various colors which may be assigned to the font size of any 
selection.

The various changes that can be made to any specific component are listed in the chart below.

Item Color Font Line Line
Size Type Thickness

Canvas X
Water X
Islands X

Street X X X X
Highway X X X X
Freeway X X X X
Boulevard X X X X
Railroad X X X X
Boundary X X X X
Interchange X X X X
Utility X X X X
Geological X X X X
Other X X X X

Small City X X
Large City X X
Target City X X
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Surface Street X X
User Text X X
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Changes to any of the aforementioned can be made by highlighting an item in the Item Indicator box, then
scrolling to the desired selection in the appropriate  Selector box, depending on whether Fonts, Colors or
Line Types are being changed.

As selections are made, any changes are immediately displayed in the Sample box.

Example: To change the WATER color

• Highlight Water in the Item Selector box while in the first (Lines) Preferences Dialog box.
• Click on the desired color in the Color Palette.

The color change is reflected in the Sample box. 

The areas of the Line Type Selection and Font Type Selection Dialog boxes are described below.

Sample box (The Line Type Selector and The Font Size Selector Dialog boxes)

Any changes made are immediately displayed in the Sample box, including Color, Line Type, Thickness
and Text Fonts. Various combinations can be experimented with until the required display characteristics
are achieved.

Font Size Selector Dialog box

All of the available font sizes are listed here. Scroll up and down the list by clicking on the arrow buttons.
Clicking on a particular Font Size assigns that Font Style to the selected component.

Example:

Click on Large City in the Item Selection box, scroll down the Font Size Selector box by clicking on the
arrow buttons, then click on 16 Points. The words Large City are displayed in the new font size.
A different color can also be assigned to the particular item's font size. This can be useful for identifying
different cities and or creating color groups for easy reference.

The Color Palette (both The Line Type Selector and Font Size Selector Dialog box)

The Color Palette shows the 16 different colors that may be assigned to any element of the display. It may
be used with any item in the Item Indicator box.

To select a color move the pointer to the desired color and click on it. An audible click may be heard from
the computer (if a speaker is attached) and the color change is reflected in the Sample box.

NOTE: There must be a contrast between canvas and text. Selecting a white canvas with white text results
in an invisible label display.

Line Type (Lines Dialog box)

Various line types are available, from solid to dashed lines to dots. Clicking on the  Line Type Selector
allows rotation through the different available line types, with the line currently selected displayed in the
Sample box. When the selected Line Type is satisfactory, stop clicking and go on to another selection.
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Line Thickness (Lines Dialog box)

Operates in the same way as Line Type. Having selected a specific item in the Preferences box, click on
the the Line Thickness selector until the display is adequate.

NOTE: Thickness of a line affects rewrite drawing speed of the display. Thicker lines draw slower on
many monitor types. In addition, thicker lines may obscure any thinner lines close to them.

Selector Buttons

The Selector Buttons perform the following functions:

OK

Accepts the selected changes and returns the user to the last displayed map. It does not save the changes
for  use  in  another  session.  To save the  display parameters,  save  the current  session after  making any
changes from the Preferences Menu.

Cancel

Cancels all changes made in the current session and returns the user to the main map.

Default

Cancels any changes (current or previous) and resets the display to the original  Key Travel Map  for
Windows parameters.

Font>>>>/<<<<Lines

Toggles between the Lines or Fonts Dialog boxes.

The Modify Fonts/Colors/Lines Tool

The Modify Fonts/Colors/Lines Tool is the same as selecting Preferences from the File Menu.

SoftKey: Changing The Way America Buys Software 14



Key Travel Map CD-ROM for Windows

Hardcopy

This command is used to print the current map displayed to a printer that has already been selected (see
Printer setup ). When Hardcopy is selected, the Printing a Hardcopy Dialog box is displayed.

The Printing a Hardcopy Dialog box

Print quality selection can be made as per the printer(s) installed to run with the Windows version. Refer to
the Windows Manual for Printer Setup and Option information.

Bear in mind that print density can have a significant effect on both the quality of the hardcopy and the time
it takes to print the desired map. The printing speed is mainly dependent on the available hardware and
Windows configuration; the amount of RAM available to the system; the capabilities and resources allotted
to the Print Manager; the actual installed printer being used and the amount of internal memory. Once
again, refer to Windows and Printer documentation to achieve optimum results and printing speed.

For draft copies print maps at a low density. Such maps may not be of a good quality for final work, but
they print faster than high density copies.

The Print the Map Tool

The Print the Map Tool initiates the same sequence as selecting Hardcopy from the File Menu. Once the
Print the Map Tool is clicked, the procedure is identical to that previously described.
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Exit

Clicking on Exit ends the current session and returns the user to the Program Manager. Before exiting Key
Travel Map for Windows the following screen is displayed.

Saving Changes on Exiting

This gives the user an option of saving any changes to the opening parameters of  Key Travel Map for
Windows. Saving current changes automatically creates a Key Travel Map for Windows Start Up session.

The Edit Menu

The Edit Menu allows work to be copied to the clipboard, display characteristics of certain  Key Travel
Map window tools to be changed, and  a currently displayed map to be edited directly, adding or deleting
streets. Clicking on the Edit Menu in the Menu Bar reveals the following menu.

The Edit Menu
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Copy

This command transfers the currently displayed map to the Clipboard. Once in the Clipboard, the map can
be imported into many other Windows applications. These can include word processing programs, paint
programs, etc.

If this command is used be aware that saving a map to the Clipboard  overwrites anything else in the
Clipboard. To use or manipulate an image in the Clipboard, save it as a file before copying another map to
the Clipboard. A Windows manual provides further possibilities and options for items in the Clipboard.

The Copy Tool

The Copy Tool displays Copy the Current Map to the Clipboard when the mouse pointer is placed on it.
Clicking  on  this  automatically  copies  the  currently  displayed  map  to  the  Clipboard  for  use  in  other
programs.

NOTE: The Copy Tool does not save work.

There are further selections that are toggles for turning the Tool Bar,  Status Bar and Scroll Bars on and
off.

Tool Bar

Clicking on this either turns on the Tool Bar if it is not displayed, or turns it off if it is displayed on the
screen.

Status Bar

The Status Bar is just above the Scroll Bar at the bottom of the screen. It displays the current map or the
function of the Tools in the Tool Bar. It can be turned off with this command.

Scroll Bars

This command turns the Scroll Bars on the right and bottom of the screen on and off.

NOTE: If the Scroll Bars are hidden it is not possible to scroll up, down or sideways.

Street

This Menu selection enters the Street Editor. Clicking on Street changes the display to the one below.

Selecting the Street Editor
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Roads on a map can be added, modified or deleted using the Street Editor.

NOTE: The Street Editor physically changes map databases. Key Travel Map for Windows should be re-
installed if serious mistakes are made e.g. roads inadvertently deleted. The Street Editor does not have an
UNDO capability.

Two options are available from the Street Editor: New and Modify.

New

Create and Add new streets to the displayed map.

Modify

Modify street characteristics: names, direction, etc.

Modify Street

There are four steps to modifying an existing street:

• Activate the Modify Street Dialog box
• Click the LEFT mouse button on the street to be changed
• Enter the required changes
• Accept the changes

When the Modify option is selected, the Modify Street Dialog box is displayed, with all of the fields blank.
Click the LEFT mouse button on the street to be modified, and the Modify Street Dialog box displays the
characteristics of the selected street.

The Modify Street Dialog box
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To affect a change, simply enter the new information.

The Modify Street Dialog box contains the following command buttons:

Copy Prior

Copies the previously accepted street information into the Modify Street Dialog box. This is useful for
changing a long stretch of road. For example, using Copy Prior to change I-405 to San Diego Freeway will
only require typing the name once.

Accept

Save the current information to disk.

Exit

Closes and exits the Modify Street Dialog box.

Delete

Removes a selected street. This operation is permanent.

One-Way

Denotes a one way street. Clicking twice on this button toggles the direction.

New
Creating a Street

New streets are created as extensions of existing streets. To create a new street, select the New command in
the Street Editor and the New Street Dialog box is displayed. Click on the anchor and the cursor will
change to the following figure:

To create a new street, Anchor on to an existing street. To anchor a new street, click on the street to be
anchored to. The New Street Dialog box is regenerated with the characteristics of the selected street.
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New Street Dialog box

Make any required changes to the information in the New Street Dialog box and click the LEFT mouse
button at the point of the screen where the street will end.

The New Street Dialog box contains the following buttons:

Flip

Changes the side of the street to be anchored to.

Anchor

Initiates the anchoring procedure as previously outlined

Done

Saves everything drawn up to the last click of the mouse button.

Type Field

Enter Street, Blvd., Hwy, Frwy, etc. This must be a valid type.

The Streets Menu 

The Streets Menu is used for locating specific streets and roads. The Streets Menu is accessed by clicking
on Streets in the Menu Bar, or by Pressing Alt-S.
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The Streets menu

There are three options in the Streets Menu:

• Find Street...
• Minimum Detail
• Street Labels

Find Street..

This command is used to pinpoint a specific location, street or highway in a Key CityMap. After invoking
the Find Street.. command, Key Travel Map for Windows displays the following Dialog box.

The Find Street Dialog box

A location can be found by entering the following information:

Number

Enter a Street Number (optional).

Street

The Name of the Street.

Direction

The direction of the Street (e.g., North (N), South (S), etc.). This entry is optional.
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Type

The Street type may be entered in abbreviated form (optional):

Street = St
Highway = Hwy
Boulevard = Blvd
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Cross Street

Enter the Name of a Street which intersects the street to be located.
After the above information has been entered the user has the option to Search for the location or cancel the
procedure. Clicking on Search  in the Search Street Dialog boxproduces a listing of possible addresses as
follows:

The Locate Street Dialog box

Any unspecified entries are ignored. If a street type is not specified, then type is not used to find the street.
Once the listing of possible addresses is displayed the user has the following options: cancel the procedure,
go to one of the displayed listings, or return to the Search Mode.

Go To

Highlighting one of the addresses and clicking on Go To causes the selection to be displayed near the center
of the screen. In addition, the selected address has a "map pin" within the selected city block to identify it.
Refer to the following figure.

Find Street - The Go To Command

The other two available commands in the Streets Menu are Minimum Detail and Street Labels.

Minimum Detail
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Selecting Minimum Detail removes all streets other than Highways, Freeways and major Boulevards. The
default colors for these roadways are red, green and blue. Minimum Detail is active when a check mark is
displayed next to the item in the Menu listing. Clicking on this command toggles the display between
Minimum and Default level detail.

NOTE: This command can also be used at the State or National level. Outside a City map, the Minimum
Detail command displays only Freeways and Highways.

Street Labels

Clicking on Street Labels turns the default level of street names on and off in the City Display. When this
command is invoked every third or fourth roadway is labeled. This prevents the display from appearing
overly  cluttered.  For  enhanced  performance,  streets  should  not  be  labeled  unless  the  Zoom is  set  to
approximately a two mile area.

Labeling a Street

In many cases the default level of street names may not be sufficient to create a route or locate a desired
location. The option to add any street names however is also available. Any segment of any street can be
easily labeled by clicking the LEFT mouse button on the desired city block. When a city block or road
segment is selected in this manner, an information box similar to the following is displayed.

Street Information Dialog box

When satisfied with the selected information click on OK to label the street . If the street name is not to be
placed on the map, select Cancel.

NOTE: Any street names remain on the map until they are deleted as described in the following section.
Take care not to obscure the map when labelling streets.
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Removing a Street Name
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Removing a Street Name

In a similar fashion, any street label can be removed from the display. To remove a street name click the
LEFT mouse button on the street block where the name is displayed. The previous figure is displayed.
The displayed street name can be removed by clicking on Delete in the Dialog box. This sequence can also
be used to modify or verify street names. To change a street name enter the change in the Text box as in the
previous display, then click  OK. Selecting  OK then returns the user to the map display, while Cancel
effects no changes.

The Places Menu

The Places Menu works in much the same way as the Streets Menu, but is used primarily to locate towns
and cities  on the  State or  National (U.S.A.) map. Clicking on the  Places Menu reveals the following
commands.

The Places Menu

Find Place...

Activating the Find Place.. option in the Places Menu displays The Find Place Dialog box.

The Find Place Dialog Box

To pinpoint a location, enter both the City and State, or simply the City name. The search is affected in two
ways:

• If  only the City Name is  entered,  Key Travel  Map for  Windows  searches  all states  for  a
corresponding match. The following Dialog box is displayed.
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Search Alert - No State Specified

This alert notifies the user that when no state has been specified, Key Travel Map for Windows searches
through all the states for a matching place name, and this may take several minutes (depending on the
operating speed of the computer).

• If both the City Name and the State are entered, Key Travel Map for Windows searches for a 
match only in the requested state.

When the search is restricted to a location within the boundaries of one state, the response is practically
instantaneous.

The search itself produces matches to the Name entered and also  approximates the spelling of the request.

Example:

If a search for BOIS is entered, IDAHO,  Key Travel Map for Windows returns four possibilities, all of
which contain bois in the name. If the request is spelled BOSE, IDAHO, Key Travel Map for Windows
will not find any matches (No match for BOSE).

Upon finding one or several matches, the following Dialog box is displayed:

The Locate Place Dialog box
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Cancel

Selecting Cancel returns the user to the currently displayed map.

SoftKey: Changing The Way America Buys Software 28



Key Travel Map CD-ROM for Windows

Go To

Selecting Go To after highlighting a choice in the listing redraws the map with the pinpointed location at its'
center. The target city is labeled in a contrasting color (the default is red on color VGA display). If there is
more than one location (see the example above), simply highlight the desired City or Town, then click on
Go To.

<<<<Search

Selecting <<<<Search returns the user to the initial Find Place Dialog box, where another search can be
executed.

The Search/Go To A Place Tool

Clicking  on  the  Search/Go  To  A Place Tool in  the  Tool  Bar initiates  the  Find Place sequence.  The
procedure is identical as that described in the previous section.

Set Detail

The Set Detail feature allows the display to be customized by increasing or decreasing the number of cities
and towns that are displayed on the map. Invoking this command produces The Place Detail Dialog box.

The Place Detail Dialog box

The detail level can be set from 0 to 16, and the selected level determines which places are displayed on the
current map. Essentially, the higher the detail level is set, the smaller the towns that are displayed. At the
highest detail level  16, ALL cities and towns within the displayed area are labeled on the map. In any
heavily populated area, with the detail level at 16 there are usually far too many city labels to conveniently
read the map.

The best thing to do is to experiment with the various settings to establish the level of labels to be displayed
in any given area.

There are three elements to keep in mind:

• The Zoom level at which the user is operating.
• The area which is being displayed, whether it is a sparsely populated area like Montana, or a  

dense megalopolis like the New York City area.
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• The defined intentions in working with the display.

SoftKey: Changing The Way America Buys Software 30



Key Travel Map CD-ROM for Windows

If an attempt is being made to map a route in a densely populated area, a large number of labels may
obscure the required routes and highways. Define what is to be done with the displayed area before setting
a high level of place labels.

If  a  high level  of  detail  is  obscuring the  map,  change the  number  to  a  lower setting and the  map is
automatically regenerated reflecting the new level of detail.

Place Labels...

This command turns the currently displayed labels On and Off at the State or USA View. This convenient
feature is used to display only streets or roads without place labels which could overwrite certain roads.

This command also works at the City level. When Place labels are turned off, any city name within a City
map are not displayed.

The View Menu

This command changes the display characteristics of Key Travel Map for Windows, enlarging or reducing
the map displayed in the viewing area. The View Menu contains the following options.

The View Menu

Prior map

This command returns the user to the map displayed immediately before the current display. The  Prior
Map command acts like a toggle switch between the current display and the previous one allowing the user
to go back and forth.

Example:

The user has a current display (Display 1) with default labels and decides to add labels by setting the detail
level to 1 (see Set Detail). Now the user has a map with more labels.

A map that has had only labels added is not considered a "new" map, therefore the Prior Map command is
not available. Once views have been changed (Display 2),  zooming in on an area, for example, then the
Prior Map command returns the user to the Previous Display (Display 1), and the changes made (using the
Set Detail Command) are still activated.
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Further changes can be made to either Displays 1 and 2. Toggling back and forth carries the changes to the
active display.
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USA Map View

This command returns the display to the opening USA map level and the detail level is reset to zero.

Distance Line

The Distance Line allows the user to anchor a line at a particular point on the map and extend it to another
point. The distance between the two points is displayed in the center of the Status Bar at the bottom of the
screen.

The Distance Line feature is a toggle and is either on or off. The feature is active if there is a check mark
beside it in the Pull down Menu. To toggle it  off, select the View Menu and click on the Distance Line
option with the LEFT mouse button. While the Distance Line is active there are no other Menu choices
available. The Distance Line Tool is available to users with monitors operating in SVGA mode.

Zoom In...

This command is used to increase the display area of a specific portion of a map.

Selecting Zoom In... turns the cursor into a small magnifying glass.

The Zoom area is extended to the right and down from the starting point. Place the cursor so that the area
to be zoomed in on starts as a LEFT hand corner of a "box". Click the LEFT mouse button and "drag" the
magnifying glass down and to the right. Moving the mouse causes a Zoom box to grow with the selected
point as its' upper left corner. The Zoom box outlines the area which is displayed on the screen. When the
area covered is satisfactory, click the LEFT mouse button once again and the map is redrawn with the
boxed area filling in the screen. The Zoom In... command can be used consecutively, but the minimum area
which can be displayed is 35 miles at the State level, and 1 mile at the Street level map. See the notes at the
end of this section regarding the Zoom Tools.

Change Scale

The  Change Scale feature allows the user to specify exactly, in miles, the coverage in the map display.
When a map is  first  opened,  whether  it  is  the  U.S.A. map or  the  Hollywood map (or  any other  Key
CityMaps installed), the  Distance box on the  Status Bar displays the coverage, or scale, of the map in
miles. In the U.S.A. map this figure is 3,825 miles. In the Hollywood map it is 1.6 miles. This figure can be
changed, altering the zoom amount or "scale" of the map, relative to the display area. 

When the Change Scale feature is selected, The Change Scale Dialog box is displayed.
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The Change Scale Dialog box
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To alter the setting displayed in The Change Scale Dialog box, type in a new number.

The minimum settings are:

City Level 1 mile
U.S.A. Level 35 miles

If  an attempt is  made to  enter  a  figure smaller  than those listed above a "beep" is  sounded from the
computer.

The maximum settings are:

City Level 100 miles
U.S.A. Level 5500 miles

This is a very useful feature in combination with the Prior Map command. The user can skip back and forth
between two different settings to get a good overview of any complex routing.

The Zoom Tools

There are two zoom tools in the Tool Bar:

• The Zoom In Tool
• The Zoom Out Tool

The Zoom In Tool

This Tool works exactly like the Zoom In feature in the View Menu.

The Zoom Out/Change the Scale Tool

This Tool is the shortcut for the Change Scale feature in the View Menu.

Both of these tools work in exactly the same way as their corresponding Menu features.

Map Center

The Map Center feature is a unique command that allows the user to automatically redraw the map with a
selected point as the new center of the map.

To use this feature click on Map Center in the View Menu and the cursor turns into a Bull's eye. Place the
new cursor over the point designated the new center of the map and click the LEFT Mouse Button. This
feature works at both the City and U.S.A. level, but the Menu feature in the View Menu is not available
when the full U.S.A. map is displayed.

The Map Center Tool

SoftKey: Changing The Way America Buys Software 35



Key Travel Map CD-ROM for Windows

The fourth tool from the left in the Tool Bar functions in the same way as the Map Center feature. Click on
the Tool and position the bull's eye on the place to be made the center of the new map.
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The Illustrate Menu

The Illustrate Menu allows the user to add Notes, Text and Arrows to highlight work further. In addition, it
can turn the display of added notes and text on or off, including deleting any added items. The Illustrate
Menu permits the following choices.

The Illustrate Menu

Add Note

The Add Note feature allows a Note to be placed on the map in much the same manner as a Note is pinned
on a bulletin board with a thumb tack.

On the map, the thumb tack is visible (if desired), but the Note is not visible until it is viewed.

When Add Note is selected from the Illustrate Menu, 

The only indication of a Note is the appearance of a "map pin" in the display. Choose the location of the
note, then click the LEFT mouse button. A Note Dialog box is displayed. The contents of the Note are
typed into this Dialog box. When the Note Text has been entered, click on OK. Click on Cancel if the Note
is not to be added.

Adding a Note (2) - Typing in the Note
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The display changes to one similar to the following illustration.

Adding A Note (3) - the Note on the Map

To edit or remove the Note, click the thumb tack, which displays the Edit Note Dialog box:

The Edit Note Dialog box

Here, the contents of the note can be edited or deleted from the display (and from the map). Either change
the contents and click OK, or remove it by clicking Delete. A Note can also be placed by using the Note
Tool in the Tool Bar.

The Note Tool

The  Note Tool initiates the same sequence as would be performed in placing a note from the  Illustrate
Menu.

Add Text

The Add Text command is used for adding text to any map on display. Clicking on Add Text causes the
cursor to turn into an "I" beam. Move the cursor to the place where the text is designated to appear and
click the LEFT mouse button. The Enter Text Dialog box is displayed.
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Adding Text (1)

Enter the desired text in the Adding Text Dialog box and Press Enter. The box disappears and the text is
displayed  at  the  point  where  the  cursor  was  placed.  The  text  takes  on  the  attributes  selected  in  the
Preferences Menu: Color and Point Size.

Adding Text (2) - Text Added and Placed

To change the text placement prior to Pressing Enter, abort the text placement procedure by Pressing ESC.
If  color  or  point  size  are  changed from the  Preferences Menu several  different  kinds  of  text  can  be
displayed on the map. 

Users with monitors operating in SVGA mode can utilize The Text  Tool to perform functions similar to the
Add Text command.

To alter or delete text, follow the same procedure as for adding and deleting notes. Click on the text and the
Text Editing Dialog box is displayed.

The Text Editing Dialog box

Here, the text can be modified by overtyping or adding some text, or deleted by clicking Delete. Click on
Cancel to abort and control will be returned to the map display. 

SoftKey: Changing The Way America Buys Software 39



Key Travel Map CD-ROM for Windows

Add Arrow

Arrows can be added to assist in finding specific locations on the maps. To add an arrow click on the Add
Arrow feature in the  Illustrate Menu. The cursor is turned into cross hairs. Place the cross hairs at the
start point for the arrow. When the cursor is moved after clicking, a red or an orange line follows the
cursor path. Stretch the line to the desired point and click the LEFT mouse button once again. The results
should be similar to the following illustration.

Adding Arrows

As with the text earlier, the arrow has the color attributes assigned to it from the  Preferences Menu. To
delete the arrow, click the LEFT mouse button on the head of the arrow. Upon doing so, the following
Dialog box is displayed.

The Removing Arrows Dialog box

Users with monitors operating in SVGA mode can utilize The Arrow  Tool to perform functions similar to
the Add Arrow command.

To remove the arrow, click on Delete. To do nothing, click OK or Cancel.

Visible

The fourth choice in the Illustrate Menu, Visible, is a toggle switch that turns any of the additions, Text,
Notes and Arrows, on or off. Such additions are visible when a check mark appears beside the item in the
Illustrate Menu.
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Delete All

If a number of Notes, Arrows and Text are placed on the map and it  becomes cluttered, remove all the
additions by using the  Delete  All  feature in  the  Illustrate Menu.  Clicking on Delete All presents  the
following Dialog box:

Illustrate Menu - Delete all Illustrations

This Dialog box allows the user to instantly remove  all illustrations  added to the map; Notes, Text and
Arrows.

Clicking OK removes the illustrations. Clicking on Cancel aborts the command and returns control to the
map.

The Overlay Menu Part 1

The Overlay Menu is one of the most powerful features of Key Travel Map for Windows. This command
functions at both the U.S.A. and City level and allows an icon on the map with an address to be located for
easy reference. This address can be a street address (at the City Level), or a notation near a location like a
city at the U.S.A. Level display.

The basic procedure for using the Overlays is as follows:

• An address is selected and noted.
• A description is added to the address.
• An icon is selected for the address.

Once this procedure is followed, the Overlay can be used on top of a map to note the selections easily by
displaying the associated icons. A number of icons are provided in the  Key Travel Map for Windows
program which should easily satisfy any requirements.

NOTE: Any Overlay File that is created and saved is in reality a dBase III compatible file which can be
modified in any program that supports dBase III files as long as formats and index requirements are met.

It  is  very important  that  the actual  structure of  the  Overlay File  is  not  modified in  any way.  A DBF
Database and several index files (NDX) are created. If the NDX files are changed or deleted or the field
structure of the Overlay File is altered, unpredictable results could occur.

The Overlay Menu is accessed by clicking on Overlays in the Menu Bar. The Overlay Menu drops down
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as shown in the following diagram.
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The Overlays Menu

Opening, Creating and Deleting Overlays

The only option that is available in the  Overlays Menu at the beginning of a new session is  Open (an
existing Overlay).The remainder of the menu options are "grayed out." When the Open selection is clicked
in the Overlays Menu, the following Dialog box is presented:

The Open Overlay Dialog box

The existing Overlays are listed in the Dialog box, and there are three choices: OK, Cancel, Delete.

Opening an Overlay

To open an existing Overlay highlight with the mouse pointer and click on OK. Click on Cancel to abort.

Creating a New Overlay

Type in a unique replacement name to replace the item above the list of existing Overlays. 

To accept the new name and allow Key Travel Map for Windows to create the Overlay, click on OK.

NOTE: The new Overlay Filename  must conform to normal DOS conventions (up to a maximum of  8
letters). Key Travel Map for Windows automatically supplies the DBF pointers and indexing requirements
for the new file.
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Once a Filename has been entered, the new Overlay File is created and automatically opened, permitting
the user to enter data that can be saved within this Overlay File. At this point, the Overlay Input Dialog box
is displayed. The Overlay Input Dialog box is discussed at length later in this chapter.

Deleting an Overlay

The last option in the Open Overlay Dialog box is that of Deleting an existing Overlay. An Overlay need
not be open in order to be deleted. Click Delete, and the Delete Confirmation Alert is displayed. If Yes is
selected, the highlighted Overlay is deleted. Selecting  No clears the Alert. To return to the map display,
click on Cancel.

The Overlay Tool

The Overlay Tool can also be used to Open or Create Overlays. Click on the small Filing Cabinet in the
Tool Bar and follow the same procedure as previously outlined.

The Overlay Input Dialog box

Once an  Overlay File is opened (or created), data can be entered into it using the Overlay Input Dialog
box. Immediately on opening an existing or New Overlay, the following is displayed.

The Overlay Input Dialog box

The Overlay Input Dialog box contains the areas where relevant information can be entered.
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GROUP

This is a mandatory field and MUST be filled in. This can serve as a heading for a number of like entries
such as restaurants, parks, theaters, friends, customer types, etc.

NAME

This is also a mandatory field and MUST be filled in. Enter the name of the particular location. It could be
a restaurant, park, etc.

NOTE: Key Travel Map for Windows lists entries in an Overlay File alphabetically, so the GROUP field
should be a heading if there are a number of similar entries. Also, these entries are case-sensitive, and any
entry will NOT default to CAPITALS. Airport is not equivalent to AIRPORT.

SYMBOL

This is where an icon is selected to Geocode the particular entry. There are many icons supplied with Key
Travel Map for Windows; their selection is discussed in greater detail in the following section. The rest of
the fields in the Overlay Input Dialog box are optional, but their use facilitates finding specific locations.

STREET

Enter the relevant part of the street address.

CITY

If an Overlay File extends beyond a particular city, the user can further identify an entry by listing the city
where it would be found.

STATE

The state where the entry is located.

ZIP CODE

The Zip code.

PHONE

The telephone number (including Area Code) can be entered here.

COMMENT

There is sufficient room to enter a five line description to assist the user in pinpointing the entry.

These fields are completed for any new entry, whether in an Existing or a New Overlay File. When working
with an existing Overlay File, these fields can be scanned for information when any entry is retrieved.

On the right  side of  the Overlay Input Dialog box are the commands which can be utilized when an
Overlay File is open. With these commands the user can  Find, Add, Delete  and Update records;  Select
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Icons, Geocode a specific entry, Plot all of the Icons onto the map or Hide the Overlay Input Dialog box
and return to the currently displayed map. The available commands in the Overlay Input Dialog box are
shown on the right.

NOTE: All of the commands are not always available.

The Overlay Input Dialog box Commands

Find

This command is used to Find any entry already in an Overlay File (or to check for an entry's existence).
Clicking on  Find displays a listing of all the records currently in the active  Overlay File.  The listing
displays the GROUP and NAME information that has been listed. If the required item is not visible, scroll
down by clicking on the arrows in the slide bars to the right of the listing. 

To display the information on a specific item, highlight it with the mouse or arrow keys and click on OK
OR Press Enter. The item's information is instantly displayed.

Displaying a Selected Record

Once an item has been  Found and its'  information is  displayed,  this  information can  be modified by
moving to the desired field and overwriting the existing information. 

NOTE: Any changes that are made to an entry are not effective unless the Update button is clicked.

Add
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This command is used to Add a record to the current  Overlay File. Once information is entered into the
various fields as listed in the previous pages, the entry can be saved to the current Overlay File by clicking
on Add.

NOTE: If Add is not clicked, the record will NOT be added to the Overlay File. In order for an entry to be
valid and added to the current Overlay File, the GROUP and NAME fields must be filled in.

Delete

This command is the opposite of Add. The Delete button erases the currently displayed Entry or Item from
the Overlay File. This process is irreversible, so be certain before deleting a record.

Update

This command saves any changes made to an existing record.

NOTE: This button MUST be clicked in order to save changes.

Icon

The two icon buttons can be used to scroll through the display of twenty available icons. The Up arrow
scrolls  in  a  forward direction and the  Down arrow scrolls  backwards through the  listing.  The icon is
associated with the appropriate entry when the Input Data has been updated.

Geocode

Once an Icon is selected when modifying or adding a record, the Geocode button allows the user to place it
on a map. Once a record has been Added to an Overlay, the Overlay Input Dialog box is cleared for another
entry.

By using the Find button an item can be brought into the Input Dialog box and clicking on Geocode returns
the user to the currently displayed map.

Once at the map level, the selected icon for the currently active record can be placed anywhere on the map.

NOTE:  Because  the  Geocode button  permits  an  icon  to  be  placed  ANYWHERE on  the  map,  note
WHERE the Icon should be placed. The usual procedure is to locate the address of the entry if it isn't
known (by using the Identify Street or Find Street/Intersection command), then enter it in the Overlay Input
Dialog box.

Plot

This button plots the information specified in the Group and Name fields.

Clear 

This button clears the fields in the Overlay Input Dialog box so another entry can be entered or modified.
Remember to use the Add or Update commands where necessary before clicking on this button, otherwise
desired information is not saved.
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Hide

This button exits the Overlay Input Dialog box and returns the user to the previously displayed map.

NOTE:  The Overlay remains open until  Closed with the  Close.. command in the  Overlay Menu (see
below).

The Arrow Buttons (<<<< and >>>>)

These two buttons can be used instead of the Find command if a specific record is not being searched for.
They are very useful for browsing through the list of records. Use <<<< to scroll through the listing in
reverse order, while >>>> scrolls forwards.

The Overlay MenuPart 2

Once an Overlay has been opened, all the Overlay Menu commands are accessible. In addition, when
Geocode, Plot or Exit have been invoked, the following commands are now available:

• Update..
• Hide(Show) objects
• Identify object..
• Close..

NOTE: These commands are grayed out until an Overlay File is opened.

Update..

This command causes the Overlay Input Dialog box to be displayed, allowing the user to modify or add
records to the current Overlay.

Hide Objects..

This command is available after an Overlay has been opened and the objects placed on the map using the
Plot command. Invoking this command causes the map to be redrawn WITHOUT the object icons being
displayed.

Show Objects..

This is functionally opposite to the  Hide Objects command. Invoking this command displays previously
visible objects (already Geocoded and associated to objects in the current Overlay) to be placed on their
correct locations on the current map display.

This command operates at both the  U.S.A. and City levels.  If  the user opens an Overlay containing a
number of objects (records) which belong to a city display while the National map is being displayed, these
Icons are stacked on top of one another at the city's location.

Identify Objects..
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This command is used to identity a particular icon by displaying the information associated with the icon.
Select this command by clicking on it in the  Overlay Menu. Click on the Icon and the information is
displayed in the same manner as the Find command.

Once the information associated with the Icon is displayed, it may be modified as discussed in the Update
and Add commands. If an icon is missed, the following is displayed.
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Object not found

Click on OK to return to the map display.

Close..

This command is used to Close an open Overlay. Once an Overlay is closed the user may proceed with any
Key Travel Map operations.

NOTE: If problems occur, try deleting the .NDX files (they will be re-built automatically).

The Route Menu

The Route Menu contains all of the commands for planning and defining a route between any two points.
In addition, intermediate points or stops can be programmed. This is achieved by clicking on the Starting,
Intermediate and Finishing points, which allow Key Travel Map for Windows to create the desired route.
Once the route is defined, detailed directions can be printed to facilitate following the route.

The Route Menu is accessed by clicking on Route in the Menu Bar.

The Route menu
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Initially, the only commands that can be invoked are:
• Start Street...
• Finish Street...
• Intermediate...
• Route IQ
• Auto Scale

Start Street..

This is the starting point of the route, whether at the National (State) or City Level.

Click on  Start  Street.. and the  Route Menu disappears  and the cursor   turns  into a  Checkered Flag.
Position the cursor on the Starting Point and click the LEFT Mouse Button.

When the  Starting Point is selected, a display similar to the following is displayed, showing the Street
selected.

The Street Information Dialog box

Clicking on OK creates the Starting point of the route. The display is similar to the figure shown above:

NOTE: At both the National (State) and City Level, it is the STREET that is selected as a Starting Point.
Using Streets or Street segments allows more flexibility over using place names.

Intermediate...

Once the Starting Point has been selected, the  Intermediate.. command can be accessed. This is used to
select stops along the way or to restrict the eventual route to a specific direction. See the NOTE regarding
Intermediate Points at the end of this section.

Any  Intermediate  Points  are  routed  IN THE ORDER THEY ARE SELECTED,  so  it  is  important  to
consider the order in which to proceed along the route. Be sure that the cursor is placed on a STREET or
ROAD when selecting an Intermediate Point.

If a series of chosen Intermediate Points cause the route to double back the eventual route may become
more complex than intended.

SoftKey: Changing The Way America Buys Software 51



Key Travel Map CD-ROM for Windows

Finish Street...

Once the the  Start Point has been selected, the  Finish Street... becomes available. This is used after all
Intermediate Points have been selected, to finalize the route (select the Find Street Tool to locate the End
Point).

Simply click on  Finish Street..., then position the cursor on the street (an intersection may be selected)
where the route ends and click the LEFT mouse button. The route selection has been completed and the
route can be created.

NOTE: The Find Street.. Menu option of the Streets Menu may be used to locate the Finish Street. If that
street is off the screen Key Travel Map for Windows locates it using the normal Find street.. procedure.
Select it using the Route/Finish Street.. option. Both points need not be on the current screen to perform
routing. 

Create Route

Clicking on Create route inputs the selected information into Key Travel Map for Windows and draws the
route.  A small  square box is displayed, which can be used to move around the points selected on the
monitor and after a few seconds the route is presented as a series of small squares or diamonds with the
route itself outlined in a contrasting color as shown below:

The Created Route
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Show Directions

The Show Directions command can be accessed once the Route has been created. This is a detailed written
series of directions that can be printed and used as driving instructions. It is displayed as shown below.

Show Directions Dialog box

The distance (miles) between each point where a turn must be made is shown. By clicking on the Scroll
Buttons to the right of the Show Directions Dialog box the remainder of the route is displayed as well as
the total mileage. These directions can be printed by clicking on the Print button.

Route IQ

The Route IQ settings tell Key Travel Map for Windows whether to expand the routing possibilities within
certain parameters.
It permits the following to be changed:

• Search Depth
• Freeway MPH
• Highway MPH
• Blvd. MPH
• Street MPH
• Rush Hour

The default Route IQ setting is 10, which is usually optimum at the City (or Street) Level. Changing this
setting allows Key Travel Map for Windows to consider different possibilities in creating a route.

If the Route IQ is set to a higher number, Key Travel Map for Windows checks the route furtherest away
from the most direct route (which may not be the most convenient or sensible route) in order to facilitate
getting from Point A to Point B. A smart route takes longer to create than one with a lower number in
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Route IQ.

Example:

With the setting at  10,  Key Travel Map for Windows may ignore the possibility of using a Freeway in
order to continue the route because the Freeway is two or three miles away. If the Route IQ is set to 30 or
40,  Key Travel Map  for Windows may decide that using the Freeway will ultimately cut down on the
mileage or travel time of the projected route. It is as if Increasing the Route IQ broadens the area which
Key Travel Map for Windows should use to create the route.

Freeway MPH

Here the  default  setting is  65.  Key Travel  Map  for  Windows takes  into consideration the  speed  and
accessibility of a Freeway in plotting the route. (see Rush Hour near the end of this section).

Highway MPH

Functions in the same manner as Freeway MPH.

Blvd. MPH

Functions in the same manner as Freeway MPH.

Street MPH

As noted in the above items.

NOTE: If the user is aware that certain streets and freeways have different speed limits or average travel
speeds, this information allows Key Travel Map for Windows to consider the use or rejection of certain
streets or highways in creating an optimum route.

Rush Hour

Key Travel Map for Windows considers the existence of Rush Hour as a time when Freeways are slow and
Street traffic moves faster. If the Rush Hour button is clicked upon (putting an X beside Rush Hour), Key
Travel Map for Windows may ignore nearby Freeways as it is aware that it is ultimately quicker and more
convenient to use adjacent streets rather than the Freeway.

The Route IQ is especially useful at the City (or Street) Level. When all the factors listed above are taken
into consideration, the Route IQ  will either use or ignore Freeways, take roads which have been listed as
having higher speed limits, making its' performance both flexible and more useful.

A good experiment is to change some of the parameters and then map the same route and compare the
results.

Auto Scale

This feature automatically displays the entire created route on the map, even if the Start and Finish Points
are both off the current display.  Auto Scale automatically readjusts the scale of the display in order to
display a map where the entire route is visible.
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Acting as a toggle (on/off), Auto Scale is active when a check mark appears beside it in the Menu.

In order for Auto Scale to operate, it must be selected before the route is created.

The Routing Tools

Start Street

Clicking on this tool initiates the Start Street sequence for plotting a route.

Intermediate (select a Via road)

This tool works in the same way as the Intermediate Command in the Route Menu.

Finish Street

This tool is used to locate the Finish Point in a projected route.

Create Route

This tool creates the route after all points (including Start and Finish Points) have been selected.

If Auto Scale has been selected, any route created with this tool activates the Auto Scale Route Display.

Help

Key Travel Map for Windows on line Help is accessed by clicking on Help in the Menu Bar. Its' operation
is consistent with all Windows operations.

The Help Menu

Contents

Selecting Contents displays a listing of topics.

To get help on a particular topic, click on the main index entry and another screen presents more possible
choices. Clicking on an item displays the relevant Help screen.

Search
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Selecting Search in the Help Menu presents a screen where a specific word or phrase can be entered to find
help on that and related items.

For more information on Windows On line Help, refer to a Windows Manual.
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